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Project 1: Design the attractive Digital India poster in OpenOffice Writer using images and text formatting, and take the
print out of the same.

Solution: Perform the following steps to create a poster:

1.
2.

Open the OpenOffice Writer application.

Select the Format > Page option from the Menu bar. The Page Style: Default dialog box appears. Click the
Landscape radio button for the Orientation option in the paper Format section of the Page tab. Click the OK button
in the Page Style: Default dialog box to apply the changes.

Open the Page Style: Default dialog box again, select the Borders tab and click the Set All Four Borders icon under
the Default option of the Line arrangement section.

Select the Yellow green 4 option from the Colour drop-down list under the Line section to specify colour to the
border. Also, select the 9.00pt option from the Style list box under the Line section to specify the line style to the
border. Click the OK button.

5. Type the line ‘DIGITAL INDIA’ and select the line using the mouse or keyboard.

10.

11.

12.

13.

14.

Select the font name as Tinos from the Font Name combo box and the font size as 36 from Font Size combo box
for the selected text on the Formatting toolbar.

On the Formatting toolbar, click the B icon to apply bold style and click the Centred icon to centrally align the
selected text.

Click the down-arrow of the Font Colour icon on the Formatting toolbar. The Font colour panel appears. Select the
Red colour in the Font colour panel. The selected text becomes red. Press the Enter key on the keyboard.

Select the Insert - Picture - From File option. The Insert picture dialog box appears. Navigate to the location
where the image is saved. Select the image and click the Open button. The selected image appears in the document.

Resize the position the image as per your requirement by dragging the mouse pointer on any corner of the image.
Press the Enter key on the keyboard.

Type the line ‘Go Cashless, Go Digital’ and apply Tinos font with the font size 36. Also, make the text bold and align
it centrally. Select the Green 5 colour in the Font colour panel to apply the colour to the selected line. Press the
Enter key three times on the keyboard.

Type the line ‘Using Technology For Citizen’ and apply Tinos font with the font size 36. Also, make the text bold
and align it centrally. Select the Black colour in the Font colour panel to apply the colour to the selected line. Press
the Enter key three times on the keyboard.

Type the line Source: http://digitalindia.gov.in/ and apply Tinos font with the font size 22. Align the text in the
centre. Select the Black colour for the selected text from the Font colour panel.

Select the File = Save As option from the Menu bar. The Save as dialog box appears. Type the name of the poster
as ‘poster’ in the File name combo box. Click the Save button.

The poster is saved as a Writer document with the name poster.odt, as shown in Figure 1.
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Figure 1: Poster

Project 2: Suppose you are a class teacher and you want to send a letter to the parents of your class students in order
to inform them regarding their ward’s performance. Hence, you are providing your official contact details in case of
meetings demanded by parents. Use mail merge feature of OpenOffice Writer to create the letters for the parents with
the necessary details.

Table 1: Sample Data for mail Merge

STUDENT NAME  CLASS CLASS_TEACHER MOBILE_NUMBER EMAIL CONTACT_TIMING
Rakesh Singh 5th Sunita Arora 9999444333 rakesh.singh@abcschool.com 12:00 to 12:30PM
Varun Grover 7th Nitin Chopra 9955446622 varun.grover@abcschool.com 12:00 to 12:30PM
Puneet Singh 9th Javed Khan 7415652123 puneet.singh@abcschool.com 12:30 to 1PM
Vinayak Kumar 10th Priya Singh 8521788945 vinayak.kumar@abcschool.com 12:30 to 1PM

Puja Mishra 4th Yogesh Garg 9554466622 Puja.mishra@abcschool.com 1:00 to 1:30PM

Dated Nov 15, 2018

Dear parents/Guardian,

| am the class teacher of your ward [Student Name] studying in [Class]. As a teacher, it is my duty to guide
your ward and provide him/her every opportunity to excel in his/her studies. As we know that much of
the learning of a child takes place at home, your cooperation is vital for the child’s overall development.
Please feel free to share your views with me in this regard. You can get in touch with me on my mobile
number [Mobile_Number] or mail me at [Email] | am generally available from [Contact_Timing].

Yours sincerely,
[Class_Teacher]

Class teacher of [Class]

ABC Public School, New Delhi

Figure 2: Formal Letter
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Solution: Perform the following steps to create and save the mail merge in OpenOffice Writer:

1.

® NS U oW

10.

11.
12.
13.

14.
15.

16.

17.

18.

19.

20.

21.

Open the OpenOffice Calc application and enter the data as shown in Table 1 in the opened worksheet named
Sheet 1.

Select the File = Save As option from the Menu bar. The Save as dialog box appears. Type data in the File name
combo box to give a name to the workbook. Now, click the Save button.

Select the File = Exit option to close the OpenOffice Calc application.

Open the OpenOffice Writer application and type the content of the letter in the same format as shown in Figure 2.
Select the File > Wizards - Address Data Source option. The Address book Data Source Wizard opens.

Select the Other external data source radio button and click the Next button to move on to the next step.

Click the Settings button. The Create Address Data Source wizard opens.

Select the Spreadsheet option from the Database type drop-down list. Click the Next button to move on to the next
step. The Database properties Connection settings wizard appears.

Click the Browse button to specify the path to the spreadsheet the containing data.

Click the Test Connection button. If the spreadsheet is connected successfully, then a message box appears with
message The Connection was established successfully. Click the Ok button to close the message box.

Click the Finish button to close the Database properties > Connection settings wizard.
Click the Next button to move on to the next step of the Address book Data Source Wizard.

Type Addresses6 in the Address book name text box to give a title under which you want to register the data
source. Now, click the Finish button to close the Address Book Data Source Wizard.

Select the View —> Data Sources option from the Menu bar. The Data Source View pane opens.

Double click the Sheet1 option under the Addresses6 —> Tables node. The database table opens on the right side of
the Data Source View pane.

Drag and drop the fields from the database table. For example, drag and drop a field <Class_Teacher> on the place
of [Class_Teacher] in the letter.

Save the document with name ‘Mail_Merge.odt'.

Select the File > print option from the Menu bar. A message box appears with the message Your document contains
address database fields. Do you want to print a form letter? Click the Yes button to print a form letter. A Mail Merge
dialog box appears.

Select the File radio button under the Output section. The Save merged document section gets enabled. By default,
the Save as a single document radio button is selected. Now, click the Ok button, The Save as dialog box appears.

Select the location to save the mail merged document. Type ‘mail_merged_letter’ in the File name combo box and
click the Save button.

Open the mail_merged_letter.odt document. You can see that the document has one page for every record of the
table.
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The snapshot of the mail merge writer document is shown in Figure 3.
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Figure 3: The Mail Merge Document

The snapshot of the final letter is shown in Figure 4.
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Figure 4: Final letter with actual data from the Data Source
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Project 3: Create a report in OpenOffice Calc and make a line chart on the basis of data given in the table to show
variations in the minimum and maximum temperatures of the six days. The weather forecast of a city for six days is given
in the following Table.

Table 2: Sample Data for line chart

TEMPERATURE (°C)

DATE MINIMUM MAXIMUM WEATHER FORECAST
Apr 23, 2018 23 42 Clear sky

Apr 24,2018 23 43 Clear sky

Apr 25, 2018 23 44 Clear sky

Apr 26, 2018 24 43 Partly cloudy sky
Apr 27,2018 24 43 Partly cloudy sky
Apr 28, 2018 24 43 Clear sky

Solution: Perform the following steps to create a report and a line chart in OpenOffice Calc:

1. Open the OpenOffice Calc application. A blank workbook opens with Sheet1. Now, type the content of Table 2 into
Sheetl.

2. Select the cells from A3 to C9. Now, select the Insert > Chart option from the Menu bar. The Chart Wizard is
displayed on the screen.

3. Select the Line chart type from the Choose a chart type list box and click the Points and Lines icon. Now, click the
Next button three times. The Chart Elements step appears.

4. Type Weather Forecasting, Date, and Temperature in the title, x-Axis and y-Axis text boxes, respectively. Click the
Finish button to close the wizard. A line chart showing variations in the maximum and minimum temperatures is
displayed.

5. Save the report with the name ‘Weather_Report’ in the appropriate folder.

The report is saved as a Calc workbook with the name Weather_Report.ods, as shown in Figure 5.
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Figure 5: Weather Forecasting report
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Project 4: Create a sheet in OpenOffice Calc with the following data:
Table 3: Sample Data

CUSTOMER NAME MRP (IN.X.) DISCOUNT AMOUNT TO BE PAID
Anil Yadav 52,500
Animesh 25,000
Dipankar 37,800
Gajendra 31,000
Gaurav Rajput 41,200

Now, perform the following tasks on the sheet:
i. Give discount to the customer as per the given criteria:

MRP > 50,000 = 20% discount
MRP >= 40,000 = 15% discount
MRP >= 30,000 = 10% discount
MRP < 30,000 = 5% discount
ii. Calculate the amount to be paid by each customer after deducting the discounted amount.
Solution:

i. Perform the following steps to calculate discount to the customer:

1. Open the OpenOffice Calc application. A blank workbook opens with Sheet1. Now, enter the content in sheet 1
as given in Table 3.

2. Type the formula =IF(B2>50000;B2%*20;1F(B2>=40000;B2%"15;IF(B2>=30000;B2%"10;IF(B2 <30000;B2%"5))))
in the C2 and press the Enter key to apply the formula on the cell.

3. Place the cursor on the cell C2, move the mouse over the fill handle, and drag the mouse along with column C
till the last row of data. The formula on the cell C2 is applied to all the other cells of the same column.

The discounted amount gets displayed, as shown in Figure 6.

ii. Perform the following steps to calculate
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Figure 6. Figure 6: Customer table
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Project 5: Create a presentation in OpenOffice Impress on the topic ‘Pollution and Global Warming’. Note that this
presentation will have text as well as images. Each slide should appear with different transition effect.

Pollution and Global Warming

Types of Pollution
Definition of Pollution
There are five types of Pollution

* Pollution is defined as the process of contaminating the air, - Water Pollution
water and soil by discharging harmful substances into it. = Air Pollution

* Pollution leads to an unhealthy environment that badly = Land Pollution
influences the life of humans. = Noise Pollution

- Radioactive Pollution

Causes of Global Warming

Conclusion
r = = Natural t: q
Definition of Global Warming aturatimpacts - We must know about things that cause polluted and global
- Change in sun's energy output
warming

- Clouds

*Global Warmingis the term used to describe anincrease in the T - We must know the ways to dispose harmful materials

temperature of the Earth —lErEes = We must use products that can be easily disposed

*Glebal warming causes climatic changes « Human Impacts = We must teach our younger generation about the bad effects

- Greenhouse gases like CO2, Methane, etc of pollution and the ways to prevent it

Figure 7: Content of the slides for the presentation on ‘Pollution and Global Warming’

Solution: Perform the following steps to create a presentation in OpenOffice Impress on ‘Pollution and Global Warming’:
1. Open OpenOffice Impress. The Presentation Wizard appears.

2. Select the Empty presentation radio button under the Type section of Presentation Wizard. Click the Next button.

3. Select the Presentation Backgrounds option from the drop-down list under the select a slide design section. Now,
select the Blue Border from the list box. Click the Next button.

4. Click the Create button to create the presentation. The OpenOffice Impress application window opens with a blank
slide. The slide contains the design you have selected.

5. Select the Title Slide layout from the Layouts pane under the properties panel and type Pollution and Global
Warming in the Click to add title text box.

6. Select the Insert = picture - from File option. The Insert picture dialog box appears.

Select the image and click the Open button. The selected image appears on the slide. Resize the image as per your
requirement.

8. Select the Insert > Slide option from the Menu bar. A new slide is added to the presentation. Similarly, add four
more slides to the presentation.

pollution.odp = OpenOffice Impress - B x
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+ Pollution leads to an unhealthy environment that [ Land Polution %
by performing steps 6 and 7. e e o et Rt i [i
12. Save the presentation with |
the name ‘pollution’ in the R - S - . - ®
. 1 Causes of Global Warming | Conclusien |
appropriate folder. oeitimor oot wmng S ' R —
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o Slide 1/6 | lyt-aqua

Figure 8: The slide sorter view of the presentation on ‘Pollution and Global Warming'.
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Project 6: Create a presentation for product advertisement in OpenOffice Impress to provide information related to
popular smartphones. Each slide must appear with different background colour, animation and sound.

Kids’ Learning Laptop Overview Features

O Kid’'s Learning Laptop is an | O Type — Educational toys
educational tool for O Battery required — 4 AA size

O kids up to 5 years. O Screen Size — 46 inches
O It assists in learning letters,
words, and numbers

O with fun and without any stress.
O Kids can also play games in this

laptop.
Skills Enhancement Product Highlights How to Purchase?
O Stage 1 — Alphabet recognition | © Product Code — 265962 O You can purchase it from our website
O Stage 2 — Learning spellings and | © Product Category — Toys www.kidslearninglaptop.com
pronunciation O Average Customer Review — 5| O This product is also available on
O Stage 3 — Learning numbers and out of 5 stars various online shopping websites.
tables O Kid’s Learning Laptop Price —
O Stage 4 - Playing games, 1249.00

melodies and musical notes

Figure 9: Content of the Slides for the presentation on the Advertisement of a product

Solution: Perform the following steps to create and save the presentation in OpenOffice Impress:

1. Open OpenOffice Impress. The presentation Wizard is displayed on the screen. Select the Empty Presentation radio
button Under the Type section of Presentation Wizard. Click the Next button.

2. Select the presentation Backgrounds option from the drop-down list under the Select a slide design section. Now,
select the Blue Border design from the list box. Click the Next button.

3. Click the Create button. The OpenOffice Impress application window opens with a black slide. The slide contains
the design you have selected.

4. Select the Title Slide layout from the Layouts pane under the properties panel and type ‘Kids Learning Laptop’ in
the Click to add title text box.

Select the Insert = Picture = From File option. The Insert picture dialog box appears.

Select the image and click the Open button. The image appears on the slide. Resize the image as per as your
requirements.

7. Select the insert = Slide option from the Menu bar. A new slide is added to the presentation. Similarly, add four
more slides to the presentation.

Select the Title, Content layout from the Layouts pane for each slide. Type the content given in Figure 9 in all slides.

9. Click the Slide Transition icon from the Sidebar and select the Other Sound option from the Sound drop-down list
under the Modify transition section. The Open dialog box appears.

10. Locate the audio file and click the Open button to add the audio file to the slide. Select the Loop until next sound
check box for playing the current music and click the Apply to all slides button under the Advance slide section to
apply the sound effect on every slide of the presentation.
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Save the presentation with the name ‘product_advertisement’ in the appropriate folder, as shown in Figure 10.
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*Stage 2— Learning spefings and pronunciation
+Stage 3 Learning numbers and tables

+Stage 4 - Playing games, melodies and musical
nates

Product Highlights

Product Code - 265962

+Product Category - Tays

+Average Customer Review— 5 out of 5 stars.
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Figure 10: The slide sorter view of the presentation for the advertisement of a product.

Project 7: Create a Scratch program for the following colourful star.

Figure 11: Colourful star

Solution: Perform the following steps to create the scratch program of colourful star:

1.
2.
3.

Open Scratch. You will see the Scratch Mascot, i.e. a cat, at the Stage.

Drag and drop the When flag clicked event from the Events block category to the Script area.

Drag and drop the set x to block from the Motion block category to the Script area at the bottom of the When flag
clicked event. Set the x to 0.

Drag and drop the set y to block from the Motion block category to the Script area at the bottom of the set x block.
Set the y to 0.
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5. Make a variable step under Data block category and Drag and drop the set step to block from the Data block
category to the Script area at the bottom of the set y block. Set the step variable to 0.

6. Drag and drop the clear block from the Pen block category to the Script area at the bottom of the set to block.
7. Drag and drop the pen down block from the Pen block category to the Script area at the bottom of the set to block.

8. Drag and drop the set pen color to block from the Pen block category to the Script area at the bottom of the pen
down block. Set the pen color to green.

9. Drag and drop the repeat control from the Control block category to the Script area at the bottom of the set pen
color block. Set the repeat to 100.

10. Drag and drop the change pen color by block from the Pen block category to the Script area inside repeat control.

11. Drag and drop the pick random to block from the Operators block category to the Script area inside change pen
color by block. Set the number from 1 to 100.

12. Drag and drop the move 10 steps block from the Motion block category to the Script area at the bottom of the
change pen color by block and inside repeat control. Set the number of steps for moving to step variable.

13. Drag and drop the turn 15 degrees block (Clockwise) from the Motion block category to the Script area at the
bottom of the move 10 steps block and inside repeat control. Set the number to 135.

14. Drag and drop the change by block from the Data block category to the Script area at the bottom of the turn 15
degrees block and inside repeat control. Set the step by 3.

15. Drag and drop hide block from Looks block category to the Script area at the bottom of the repeat control block.
16. Click the When flag clicked event in the Script area.

17. A Colourful star is drawn in the Stage, as shown in Figure 11.
DID YOUKnow

{98y
g The steps to create a

variable in Scratch are as
follows -

1. Click Make a Variable
under Data block
category. The new
variable window
opens.

2. Type the name of
the variable in the
Variable name Text
box. In our case,
variable name is step.

3. Click Ok.

The variable is created.
\_ _J

Figure 12: Coding of colourful star in Scratch

OR
Project 7: Write a Python program to calculate square root of an entered number.

Solution: Perform the following steps to create square root program in Python:
1. Open the gedit editor.
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Write the code in the editor given in Listing 1.
Save the file with Square_root.py
LISTING 1: Code of Square_root.py file

# Python Program to calculate the square root

num = float (input (‘Enter a number: '))

num sqgrt = num ** 0.5

print (‘The square root of %0.3f is %0.3f’%(num ,num sqgrt))

Open the Terminal window, and navigate to the location where the Square_root.py is saved.

5. Type python3 ./Square_root.py command to execute the code of Listing 1.

The output of Listing 1 is as follows:
Enter a number: 25
The square root of 25.000 is 5.000

Project 8: Create a Scratch program with customized Sprite and backdrop, and also add blocks in the Script area to play
music.

Solution: Perform the following steps to create the scratch program of customized Sprite:

1.
2.
3.

Open Scratch. You will see the Scratch Mascot, i.e. a cat, at the Stage.
Drag and drop the When key pressed event from the Events block category to the Script area. Set key to space.

Drag and drop the say block from the Looks block category to the Script area at the bottom of the When key
pressed event. Set to I can play guitar.

Drag and drop the repeat control from the Control block category to the Script area at the bottom of the say block.
Set the repeat to 20.

Drag and drop the play note block from the Sound block category to the Script area inside repeat control. Set play
note to 64 for 0.5 beats.

Drag and drop the play note block from the Sound block category to the Script area inside repeat control. Set play
note to 62 for 0.5 beats.

Drag and drop the play note block from the Sound block category to the Script area inside repeat control. Set play
note to 60 for 0.5 beats.

Press the space key in the keyboard, the sprite starts to play music, as shown in Figure 14.

':}l::f_}.
when space key pressed =
E=VT I can play guitar ¥ -08
: ¥: 38

play note for beats
3
play note for beats

3
play note m for beats

Figure 13: Coding of Customized Sprite in Scratch
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Figure 14: Customized Sprite in Scratch

OR

Project 8: Write a Python program to calculate the area of a triangle on the basis of length of its three sides entered by
a user.
Solution: Perform the following steps to create area of a triangle program in Python:

1. Open the gedit editor.

2. Write the code given in Listing 2.
3. Save the file with Area_triangle.py

LISTING 2: Code of the Area_triangle.py

A Python program to find the area of a triangle
= float (input (‘Enter first side: '))

float (input (‘Enter second side: V'))

= float (input (‘Enter third side: '))

calculate the semi-perimeter

= (a+b+c) /2

calculate the area

area = (s*(s-a)*(s-b)*(s-c)) ** 0.5

print (‘The area of the triangle is %0.2f’ %area)
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4. Open the Terminal window, and navigate to the location where the Area_triangle.py is saved.
5. Type python3 ./Area_triangle.py command to execute the code of Listing 2.

The output of Listing 2 is as follows:

Enter first side: 8

Enter second side: 6

Enter third side: 4

The area of the triangle is 11.62
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